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Preface

This User Guide has been implemented by Boot &Work, S.L. working
under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operating, to
functions, and to the technical data of the signal modules, power supply modules and
interface modules.

Intended Audience

This User Guide is intended for the following audience:

● Persons in charge of introducing automation devices.

● Persons who design automation systems.

● Persons who install or connect automation devices.

● Persons who manage working automation installation.

Warnings:

● Unused pins should not be connected. Ignoring the directive may damage the

controller.

● Improper use of this product may severely damage the controller.

● Refer to the controller’s User Guide regarding wiring considerations.

● Before using this product, it is the responsibility of the user to read the product’s User

Guide and all accompanying documentation.

● Maintenance must be performed by qualified personnel familiarised with the

construction, operation, and hazards involved with the control.

● Maintenance should be performed with the control out of operation and disconnected

from all sources of power.

● Care should be taken when servicing electrostatic sensitive components. The

manufacturer's recommendations for these components should be followed.
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● The Ardbox Family PLCs are Open Type Controllers. It is required that you install the

Ardbox PLC in a housing, cabinet, or electric control room. Entry to the housing,

cabinet, or electric control room should be limited to authorised personnel. Failure to

follow these installation requirements could result in severe personal injury and/or

property damage. Always follow these requirements when Ardbox family PLCs.

● In case of installation or maintenance of the Ardbox please follow the instructions

marked in the Installation and Maintenance section.

● Do not disconnect equipment when a flammable or combustible atmosphere is

present. Disconnection of equipment when a flammable or combustible atmosphere is

present may cause a fire or explosion which could result in death, serious injury and/or

property damage.

Avertissements:

● Les broches non utilisées ne doivent pas être connectées. Ignorer la directive peut

endommager le contrôleur.

● Une utilisation incorrecte de ce produit peut endommager gravement le contrôleur.

● Reportez-vous au Guide de l’utilisateur du contrôleur pour les considérations de

câblage.

● Avant d’utiliser ce produit, il incombe à l’utilisateur de lire le Guide de l’utilisateur du

produit et la documentation qui l’accompagne.

● La maintenance doit être effectuée par personnel qualifié familiarisé avec la

fabrication, le fonctionnement et les dangers liés au contrôleur.

● La maintenance doit être effectuée avec l’équipement hors service et déconnectée de

toutes les sources d'alimentation.

● Faites attention lors de l'entretien des composants sensibles à l'électricité statique. Les

recommandations du fabricant pour ces composants doivent être suivies.

● Les automates de la famille Ardbox sont des contrôleurs de type ouvert. Il est

nécessaire d'installer l'automate Ardbox dans un boîtier, une armoire ou une salle de

contrôle électrique. L'accès au boîtier, à l'armoire ou à la salle de commande

électrique doit être limité au personnel autorisé. Le non-respect de ces exigences

d'installation peut entraîner des blessures graves et/ou des dommages matériels

importants. Respectez toujours ces exigences lors de l'installation des automates de la

famille Ardbox.

● En cas d'installation ou de maintenance du Ardbox, veuillez suivre les instructions

indiquées dans la section Installation et Maintenance.

● Ne débranchez pas l'équipement en présence d'une atmosphère inflammable ou

combustible. La déconnexion de l'équipement en présence d'une atmosphère

inflammable ou combustible peut provoquer un incendie ou une explosion pouvant

entraîner la mort, des blessures graves et/ou des dommages matériels.
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Application Considerations and Warranty

Read and Understand this Manual

Please read and understand this manual before using the product. Please consult your
comments or questions to Industrial Shields before using the product.

Application Consideration
THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED.
THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR
PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE
NOT RATED OR DESIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY
WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESIGNED
TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE
PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE
OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or
standards that apply to the combination of products in the customer’s application or use
of the product.

The following are some examples of applications for which particular attention must be
given. This is not intended to be an exhaustive list of all possible uses of the products,
nor is it intended to imply that the uses may be suitable for the products:

● Systems, machines, and equipment that could present a risk to life or property.
● Nuclear energy control systems, combustion systems, railroad systems,

aviation systems, medical equipment, amusement machines, vehicles, safety
equipment, and installation subject to separate industry or government
regulations.

● Outdoor use, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party
certification documents identifying ratings and limitations of use that apply to the
products. This information by itself is not sufficient for a complete determination of the
suitability of the products in combination with the system, machine, end product, or
other application or use.
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Intended use or of Industrial Shields products
Consider the following:

Industrial Shields products should only be used for the cases of application foreseen in
the catalogue and the associated technical documentation. If third-party products and
components are used, they must have been recommended or approved by Industrial
Shields.

The correct and safe operation of the products requires that your transport, storage,
installation, assembly, operation and maintenance have been carried out in a correct It
must respect the permissible ambient conditions. You should also follow the indications
and warnings that appear in the associated documentation.

The product / system dealt with in this documentation should only be handled or
manipulated by qualified personnel for the task entrusted and observing what is
indicated in the documentation corresponding to it, particularly the safety instructions
and warnings included in it. Due to their training and experience, qualified personnel
are in a position to recognize risks resulting from the handling or manipulation of such
products / systems and to avoid possible hazards.

Disclaimers
Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing
purposes, even when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in
determining suitability and does not constitute a warranty. It may represent the result of
INDUSTRIAL SHIELDS’s test conditions, and the users most correlate it to actual
application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS
Warranty and Limitations of Liability.

Change in Specifications

Product specifications and accessories may be changed at any time based on
improvements and other reasons.

It is our practice to change model numbers when features are changed, or published
ratings or when significant construction changes are made. However, some
specifications of the products may be changed without any notice. When in doubt,
special numbers may be assigned to fix or establish key specifications for your
application on your request. Please consult with your INDUSTRIAL SHIELDS
representative at any time to confirm actual specifications of purchased products.
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Errors and Omissions

The information in this document has been carefully checked and is believed to be
accurate; however, no responsibility is assumed for clerical, typographical, or
proofreading errors, or omissions.

Residual Risks

The control and drive components of an Industrial Shields PLC are approved for
industrial and commercial use in industrial line supplies. Their use in public line
supplies requires a different configuration and/or additional measures. These
components may only be operated in closed housings or in higher-level control
cabinets with protective covers that are closed, and when all of the protective devices
are used. These components may only be handled by qualified and trained technical
personnel who are knowledgeable and observe all of the safety information and
instructions on the components and in the associated technical user documentation.
When carrying out a risk assessment of a machine in accordance with the EU
Machinery Directive, the machine manufacturer must consider the following residual
risks associated with the control and drive components of a PDS.

1. Unintentional movements of driven machine components during commissioning,
operation, maintenance, and repairs caused by, for example: − Hardware defects
and/or software errors in the sensors, controllers, actuators, and connection technology
− Response times of the controller and drive − Operating and/or ambient conditions not
within the scope of the specification − Condensation / conductive contamination −
Parameterization, programming, cabling, and installation errors − Use of radio devices /
cellular phones in the immediate vicinity of the controller − External influences /
damage.

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by,
for example: − Component malfunctions − Software errors − Operating and/or
ambient conditions not within the scope of the specification − External
influences / damage.

3. Hazardous shock voltages caused by, for example: − Component malfunctions −
Influence of electrostatic charging − Induction of voltages in moving motors − Operating
and/or ambient conditions not within the scope of the specification − Condensation /
conductive contamination − External influences / damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose
a risk to people with a pacemaker, implants or metal replacement joints, etc. if they are
too close.

5. Release of environmental pollutants or emissions as a result of improper operation
of the system and/or failure to dispose of components safely and correctly.
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Warranty and Limitations of Liability
Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in
materials and workmanship for a period of one year (or other period if specified) from
date of sale by Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY,
EXPRESSED OR IMPLIED, REGARDING MERCHANTABILITY,
NON-INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE OF THE
PRODUCTS. ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR
USER ALONE HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET
THE REQUIREMENTS OF THEIR INTENDED USE. INDUSTRIAL SHIELDS
DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT,
OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN
ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS
BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONSIBLE FOR WARRANTY,
REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL
SHIELDS’S ANALYSIS CONFIRMS THAT THE PRODUCTS WERE PROPERLY
HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO
CONTAMINATION, ABUSE, MISUSE, OR INAPPROPRIATE MODIFICATION OR
REPAIR.
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1. GPRS Ardbox Family HF: General Features

COMPACT PLC ARDUINO GPRS ARDBOX 20I/Os
Family LOG HF PLUS

Input Voltage 12 to 24Vdc
Fuse protection (2.5A)
Polarity protection

Input rated voltage 24 Vdc

Rated Power 30 W

I Max. 1,5A

Size 100x45x115

Clock Speed 16MHz

Flash Memory 32KB of which 4KB are used by
bootloader

SRAM 2.5KB

EEPROM 1KB

Communications I2C -- USB -- RS232 -- RS485 RS485

An/Dig Input 10bit
(0-10Vcc)

0 to 10Vac
Input Impedance: 39K
Separated PCB ground
Rated Voltage: 10Vac

5 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation

Rated Voltage: 24 Vdc

* Interrupt isolated Input
HS

(24Vcc)

5 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation

Rated Voltage: 24Vdc

5 to 24Vdc
I min: 3/6 mA

Separated PCB ground

Analog Output 8bit
(0-10Vcc)

0 to 10Vac
I max: 20 mA

Separated PCB ground
Rated Voltage: 10Vac

Digital Isolated Output
(24Vcc)

5 to 24Vdc
I max: 70 mA

Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

Imax 24Vdc: 410 mA

Digital Isolated Output
Relay

220V Vac
Galvanic Isolation

Diode protected for Relay Imax: 5A

PWM Isolated Output
8bit (24Vcc)

5 to 24Vdc
I max: 70 mA

Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

PWM Isolated
Output 8bit

(24Vcc)

Expandability I2C – RS232 – RS485 – TTL

Reference
006001001200

006001001300

Analog

Relay
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2. Technical Specifications

2.1 General Specifications:

Power supply
voltage DC power supply 12 to 24Vdc

Operating
voltage range DC power supply 11.4 to 25.4Vdc

Power
consumption DC power supply 30VAC max.

External
power supply

Power supply voltage 24Vdc

Power supply output
capacity 700 mA

Insulation resistance 20MΩ min. at 500Vdc between the AC terminals and the protective ground
terminal.

Dielectric strength
2.300 VAC at 50/ 60 Hz for one minute with a leakage current of 10mA
max. Between all the external AC terminals and the protective earth
terminal.

Shock resistance 80m/s2 in the X, Y and Z direction 2 times each.

Ambient temperature (operating) 0º to 60ºC

Ambient humidity (operating) 10% to 90% (no condensation)

Ambient environment (operating) With no corrosive gas

Ambient temperature (storage) -20º to 60ºC

Power supply holding time 2ms min.

Weight 350g max.

2.2 Performance Specification:

Arduino Board ARDUINO LEONARDO

Control method Stored program method

I/O control method Combination of the cyclic scan and immediate refresh processing methods.

Programming language
Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform
composed of a programming language. “similar to the C”).
http://arduino.cc/en/Tutorial/HomePage

Microcontroller ATmega32u4

Flash Memory 32KB of which 4KB are used by bootloader

Program capacity (SRAM) 2.5KB

EEPROM 1KB
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Clock Speed 16MHz

2.3 Symbology

Table that includes all the symbology that is used in the serigraph of the GPRS Ardbox Family

HF+:

Symbol Standard No. /
Standard Title

Standard
Reference No. /
Symbol Title

Symbol Meaning

IEC 60417 /
Graphical symbols

for use on
equipment

5031 / Direct
Current

Indicates that the equipment is
suitable for direct current only;
to identify relevant terminals

IEC 60417 /
Graphical symbols

for use on
equipment

5032 / Alternating
Current

Indicates that the equipment is
suitable for alternating current

only; to identify relevant
terminals

IEC 60417 /
Graphical symbols

for use on
equipment

5130 / Pulse
General

To identify the control by which
a pulse is started.

IEC 60417 /
Graphical symbols

for use on
equipment

5017 / Earth,
Ground

To identify an earth (ground)
terminal in cases where

neither the symbol 5018 nor
5019 is explicitly required.

IEC 60417 /
Graphical symbols

for use on
equipment

5115 / Signal lamp

To identify the switch by
means of which the signal

lamp(s) is (are) switched on or
off.

Medical Devices
Directive
93/42/EEC

CE Marking

CE marking indicates that a
product complies with

applicable European Union
regulations

ISO 7000/
Graphical symbols

for use on
equipment

0434B /
Warning symbol

Indicates a potentially
hazardous situation which, if
not avoided, could result in
death or serious injury

ISO 7000/
Graphical symbols

for use on
equipment

5036 / Dangerous
Voltage

To indicate hazards arising
from dangerous voltages
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3. Precautions

Read this manual before attempting to use the ARDBOX 20 I/Os Family HF GPRS PLUS and
follow its descriptions for reference during operation.

3.1 Arduino Board

The ARDBOX 20 I/Os Family HF GPRS PLUS PLCs include Arduino Leonardo Board as controller.

3.2 Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.3 General Precautions

The user must operate Ardbox according to the performance specifications described in this

manual.

Before using ARDBOX 20 I/Os Family HF GPRS PLUS under different conditions from what has

been specified in this manual or integrating ARDBOX 20 I/Os Family HF GPRS PLUS to nuclear

control systems, railroad systems, aviation systems, vehicles, combustion systems, medical

equipment, amusement machines, safety equipment and other systems, machines, and

equipment that may have a serious influence on lives and property if used improperly, consult

your INDUSTRIAL SHIELDS representative. Ensure that the rating and performance

characteristics of Ardbox are sufficient for the systems, machines, and equipment, and be sure

to provide the systems, machines, and equipment double safety mechanisms. This manual

provides information for programming and operating the Ardbox.

12



4. Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C

language. They can also be programmed directly using C but it is much easier working with

Arduino IDE as it provides lots of libraries that help in the programming.

Furthermore Industrial Shields provides boards for programming the PLCs much easier.

Basically it is not needed to define the pins and if those pins are inputs or outputs. Everything

is set up automatically if using the boards.

In order to install Industrial Shields boards, these are the steps that must be followed.

Requirements:

Arduino IDE 1.8.15 or above (better to always have the latest version).

Steps:

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.

2. In Additional Boards URLs write the following:

http://apps.industrialshields.com/main/arduino/boards/package_industrialshields_index.json

3. Press OK to save the changes.

4. Go to: Tools -> Board:… -> Boards Manager
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5. Search for industrialshields.

6. Click install (selecting the latest version).

Following this steps you will be able to use now the Industrial Shields Boards:
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Once the Ardbox Family is selected, an extra option will appear on Tools:

- Select the correct Ardbox Family HF PLUS Board (Ardbox Analog HF+ w/HW RS-232

GPRS, Ardbox Analog HF+ w/HW RS-485 GPRS, Ardbox Relay HF+ w/HW RS-232 GPRS

or Ardbox Relay HF+ w/HW RS-485 GPRS) depending on your jumpers & switch

configuration.

Also there are some examples of programming in File -> Examples -> Ardbox GPRS Family.

Furthermore there are some extra libraries that can be found in Industrial Shields github.

https://github.com/IndustrialShields/
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5. How to connect PLC Arduino to PC

- Connect USB port from PLC to PC.

NOTE:
Ardbox Family uses micro USB cable.

- Open Arduino IDE interface:
- Select Industrial Shields boards -> Ardbox GPRS Family
- Select the correct port.
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6. How to connect PLC to power supply

- Ardbox GPRS Family PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT

REVERSAL!

- Make sure that the live and GND connector of the power supply match the PLC.

- Make sure that the power supply mains output is not higher than 24Vdc.

- Suggested power suppliers

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types

of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC

61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-1.

WARNING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of the

equipment must be separated from the dangerous voltage cables.
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7. Ardbox GPRS pinout

IOs Table

Model Reference
Analog
Input

Digital Isolated
Input

Digital Isolated
Output

Digital/Analogic
Output Relay Output

ANALOG 006001001200 8 2 3 7 0

RELAY 006001001300 8 2 0 0 8
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8. Ardbox GPRS Family I/O serigraphy

8.1 006001001200 Zone Connections

LEFT ZONE

Ardbox
Connector

Arduino
Pin

Function

A0.61
A0.51
A0.41
A0.31
A0.21
A0.11
A0.01

Q0.92
Q0.82
Q0.7
Q0.61
Q0.5
Q0.4
Q0.3
Q0.2
Q0.1
Q0.0

GNDCOM
24VCOM

3
5
6
9
10
11
13

1
0
7
3
5
6
9
10
11
13

-
-

Analog Out
Analog Out
Analog Out
Analog Out
Analog Out
Analog Out
Analog Out

Digital Output
Digital Output
Digital Output

PWM/digital Output
PWM/digital Output
PWM/digital Output
PWM/digital Output
PWM/digital Output
PWM/digital Output
PWM/digital Output

GND
Power Supply

2 See section 9 to enable these connections

1 See section 8 to enable these connections
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RIGHT ZONE

Ardbox Connector

Arduino
Pin

RS232
HS*

Arduino
Pin

RS485
HS*

Function

A+3, 4

B-3, 4
Y+3, 4

Z-3, 4
SCL-PIN33

SDA - RST GPRS3

TX-RS2323, 4
RX-RS2323, 4

GND
5V

RESET
NC
NC
NC

I0.9
I0.8
I0.7
I0.6
I0.5
I0.4
I0.33
I0.23
I0.1
I0.03

-
-
-
-
3
2
1
0

-
-
-
-

GPRS
GPRS

18
19
20
21
22
23
8
4
12
2

-
-
-
-
3
2
4
8

-
-
-
-

GPRS
GPRS

18
19
20
21
22
23
8
4
12
2

RS485(A)
RS485(B)
RS485(Y)
RS485(Z)
SCL(I2C)

SDA (I2C) - RST GPRS
-
-

Ground
5Vout DC
RESET

-
MOSI
MISO

Analog/Digital Input
Analog/Digital Input
Analog/Digital Input
Analog/Digital Input
Analog/Digital Input
Analog/Digital Input
Analog/Digital Input
Analog/Digital Input

Digital Input
Digital interrupt

HS*: Hardware Serial
SS*: Software Serial

4 See section 9 to enable these connections

3 See section 8 to enable these connections
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8.2 006001001300 Relay Zone Connections

Left Zone

Ardbox Connector
Arduino
Pin

Function

NC
NC
NC

RESET
5Vdc
GND

RX-RS-2325, 6
TX-RS-2325, 6

SDA - RST GPRS
SCL-PIN35

R1
R2
R3

GND
24V

14
16
-
-
-
-
8
4
2
3

10
9
6

-
-

MISO / RX GPRS
MOSI / TX GPRS

-
RESET

5V Output
GND

Serial/RS232
Serial/RS232

SDA- RESET GPRS
SCL - SS

Relay 1 Out
Relay 2 Out
Relay 3 Out

GND
-

HS*: Hardware Serial
SS*: Software Serial

6 See section 9 to enable these connections

5 See section 8 to enable these connections
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Right Zone

Ardbox
Connector

Arduino
Pin

RS-485
HD*

Function

B-
A+

Z-/A0.1
Y+/A0.0

R4
R5
I0.9
I0.8
I0.7
I0.6
I0.5
I0.4
I0.3
I0.2
I0.1
I0.0
R6
R7
R8

-
-

11 (FD)*
13 (FD)*

5
3
23
22
21
20
19
18
8
4
12
2
7
0
1

RS485
RS485

RS485/ Digital Output
RS485/ Digital Output

Relay 4 Out
Relay 5 Out

Analog/ Digital Input
Analog/ Digital Input
Analog/ Digital Input
Analog/ Digital Input
Analog/ Digital Input
Analog/ Digital Input
Analog/ Digital Input
Analog/ Digital Input
Analog/ Digital Input
Analog/ Digital Input

Relay 6 Out
Relay 7 Out
Relay 8 Out

*Depending on the mode HD/FD the Y+/Z- Analog Output pins are enabled or disabled. See
section 9 to see the configurations.

22



9. Switch configuration

9.1 006001001200 Analog Model General Switches Configuration

LEFT ZONE SWITCH

Communications and inputs/outputs can not work simultaneously.

LEFT ZONE
SWITCH OFF ON

I0.8 / RS-485 DE I0.8 RS-485 DE

RS-485 DE / I0.8 RS-485 DE I0.8

I0.9 / RS-485 RE I0.9 RS-485 RE

RS-485 RE / I0.9 RS-485 RE I0.9

SDA - GPRS RST / I0.0 SDA - GPRS I0.0

SCL-PIN3 / Q0.6 SCL-D3 Q0.6

6. I0.8 / RS-485 DE – If this switch is ON the RS-485 DE is activated, otherwise the I0.8 will be

activated.

5. RS-485 DE / I0.8 – If this switch is ON the I0.8 is activated, otherwise the RS-485 DE will be

activated.

Note* To work with RS-485 DE, switch number 6 at ON and number 5 at OFF.

4. I0.9 / RS-485 RE – If this switch is ON the RS-485 RE is activated, otherwise the I0.9 will be

activated.

3. RS-485 / I0.9 – If this switch is ON the I0.9 is activated, otherwise the RS-485 RE will be

activated.

Note* To work with RS-485 RE, switch number 4 at ON and number 3 at OFF.

2. GPRS RST / I0.0 – If this switch is ON the I0.0 is activated, otherwise the (I2C) SDA - GPRS RST

will be activated.

1. SCL-D3 / Q0.6 – If this switch is ON the Q0.6 is activated, otherwise the (I2C) SCL-D3 will be

activated.

23



TOP ZONE SWITCH

TOP ZONE

SWITCH ON OFF

RS* / Q0.8 RS* Q0.8

Q0.8 / RS* Q0.8 RS*

RS* / Q0.9 RS* Q0.9

Q0.9 / RS* Q0.9 RS*

1. Q0.8 / RS* - If this switch is ON the RS* is activated, otherwise the Q0.8 will be activated.

2. RS* / Q0.8- If this switch is ON the Q0.8 is activated, otherwise the RS* will be activated.

3. Q0.9 / RS* - If this switch is ON the RS* is activated, otherwise the Q0.9 will be activated.

4. RS* / Q0.9 - If this switch is ON the Q0.8 is activated, otherwise the RS* will be activated.

Note* RS * can be RS-485 or RS-232 depending on the jumper configuration you have

chosen. To work with RS*, switches number 1 and 3 at ON and number 4 and 2 at OFF.

RIGHT ZONE SWITCH

RIGHT ZONE

SWITCH ON OFF
HD / FD Half Duplex Full Duplex
Q0.6 DIGITAL (Q0.6) ANALOG (A0.6)
Q0.5 DIGITAL (Q0.5) ANALOG (A0.5)
Q0.4 DIGITAL (Q0.4) ANALOG (A0.4)
Q0.3 DIGITAL (Q0.3) ANALOG (A0.3)
Q0.2 DIGITAL (Q0.2) ANALOG (A0.2)
Q0.1 DIGITAL (Q0.1) ANALOG (A0.1)
Q0.0 DIGITAL (Q0.0) ANALOG (A0.0)

RIGHT ZONE.

1. HD/FD – Choosing between Half/Full Duplex for the RS232 or RS485 communication. In
order to use Full Duplex, it has to be considered the TOP ZONE and the JUMPER ZONE (see
section 9).

2-8. Q0.X/A0.X – The right zone configures the outputs. If the switch is set to “ON” the Q0.X
will have the behaviour of a digital output. If it is set to “OFF” it will be analog.
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9.2 006001001300 Relay Model General Switches Configuration

LEFT ZONE SWITCH

Communications and inputs/outputs can not work simultaneously.

LEFT ZONE
SWITCH ON OFF

NC - -

HD/FD* Half Duplex Full Duplex

R5 / Pin 3-SCL R5 Pin 3 - SCL

I0.0 / GPRS RST-SDA I0.0 GPRS -
SDA

RE-RS485 / I0.4 RE-RS485 I0.4

I0.4 / RE-RS485 I0.4 RE-RS485

DE-RS485 / I0.5 DE-RS485 I0.5

I0.5 / DE-RS485 I0.5 DE-RS485

1. NC – Not Connected
2. HD/FD* – Choosing between Half/Full Duplex for the RS* communication. In order to use
Full Duplex, it has to be considered the TOP ZONE and the JUMPER ZONE (see section 9).
3. R5 / Pin3-SCL – If this switch is ON the R5 is activated, otherwise the Pin3 - SCL will be
activated.
4. I0.0 / GPRS RST - SDA – If this switch is ON the I0.0 is activated, otherwise the GPRS RST -
SDA will be activated.

1. RE-RS485 / I0.4 – If this switch is ON the RE-RS485 is activated, otherwise the I0.4 will be
activated.
2. I0.4 / RE-RS485 – If this switch is ON the I0.4 is activated, otherwise the RE-RS485 will be
activated.

Note* To work with RS-485 RE, switch number 1 at ON and number 2 at OFF.

3. DE-RS485 / I0.5 – If this switch is ON the DE-RS485 is activated, otherwise the I0.5 will be
activated.
4. I0.5 / DE-RS485 – If this switch is ON the I0.5 is activated, otherwise the DE-RS485 will be
activated.

Note* To work with RS-485 DE, switch number 3 at ON and number 4 at OFF.
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9.3 006001001200 Analog RS-232 and RS-485 Switch Configuration

ANALOG TOP ZONE

SWITCH MODE

RS* / Q0.8 ON

Q0.8 / RS* OFF

RS* / Q0.9 ON

Q0.9 / RS* OFF

RS* TOP ZONE: In order to enable the RS* protocol the TOP ZONE must be configured as it is

shown in the table.

Having this setup, the Q0.8 & Q0.9 are disabled.

4. RS* / Q0.8 - If this switch is ON the RS* is activated, otherwise the Q0.8 will be activated.

3. Q0.8 / RS* - If this switch is ON the Q0.8 is activated. otherwise the RS* will be activated.

2.RS* / Q0.9 - If this switch is ON the RS* is activated, otherwise the Q0.9 will be activated.

1. Q0.9 / RS* - If this switch is ON the Q0.9 is activated, otherwise the RS* will be activated.

ANALOG LEFT ZONE

SWITCH RS232
MODE

RS485
MODE

I0.8 / RS* DE OFF ON

RS* DE / I0.8 ON OFF

I0.9 / RS* RE OFF ON

RS* RE / I0.9 ON OFF

SDA - GPRS RST - -

SCL-D3 - -

RS* LEFT ZONE: In order to enable the RS* communication protocol it is necessary that the

switches of the left one are configured as it is shown in the table.

The ones married with “-” mean that they do not affect the RS* communication protocol.
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9.4 006001001300 Relay RS-232 and RS-485 Switch Configuration

RELAY TOP ZONE

SWITCH MODE

RS* / R8 ON

R8 / RS* OFF

RS* / R7 ON

R7 / RS* OFF

RS* TOP ZONE: In order to enable the RS* protocol the TOP ZONE must be configured as it is

shown in the table.

Having this setup, the R7 & R8 are disabled.

4. RS* / R8 - If this switch is ON the RS* is activated, otherwise the R8 will be activated.

3. R8 / RS* - If this switch is ON the R8 is activated. otherwise the RS* will be activated.

2. RS* / R7 - If this switch is ON the RS* is activated, otherwise the R7 will be activated.

1. R7 / RS* - If this switch is ON the R7 is activated, otherwise the RS* will be activated.

RELAY LEFT ZONE

SWITCH RS232
MODE

RS485
MODE

NC - -

HD/FD ON / OFF ON / OFF

R5 / Pin 3-SCL - -

I0.0 / GPRS RST-SDA - -

RE-RS485 / I0.4 OFF ON

I0.4 / RE-RS485 ON OFF

DE-RS485 / I0.5 OFF ON

I0.5 / DE-RS485 ON OFF

HD/FD: Choosing between Half Duplex or Full Duplex for the RS* communication. In order to

use Full Duplex, it has to be considered the TOP ZONE and the JUMPER ZONE (see section 9).

RS* LEFT ZONE: In order to enable the RS* communication protocol it is necessary that the

switches of the left zone are configured as it is shown in the table.

The marks with “-” mean that they do not affect the RS* communication protocol.
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9.5 006001001200 Analog I2C Switch Configuration

TOP ZONE LEFT ZONE

SWITCH MODE SWITCH MODE

RS* / Q0.8 - I0.8 / RS-485 DE -

Q0.8 / RS* - RS-485 DE / I0.8 -

RS* / I0.2 - I0.9 / RS-485 RE -

I0.2 / RS* - RS-485 RE / I0.9 -

SDA-GPRS RST / I0.0 OFF

SCL-D3 / Q0.6 OFF

I2C: Enable SCL and SDA connections (direct Arduino pins) with configuration switches. I0.0 and

Q0.6 will not be available. In order to implement this communication a 4.7kΩ pull-up resistor is

required.

The marks with “-” mean that they do not affect the I2C communication protocol.

9.6 006001001300 Relay I2C Switch Configuration

TOP ZONE LEFT ZONE

SWITCH MODE SWITCH MODE

I0.2 / RS* - NC -

RS* / I0.2 - HD / FD* -

I0.3 / RS* - R5 / Pin 3-SCL OFF

RS* / I0.3 - I0.0 / GPRS RST-SDA OFF

RE-RS485 / I04 -

I0.4 / RE-RS485 -

DE-RS485 / I0.5 -

I0.5 / DE-RS485 -

I2C: Enable SCL and SDA connections (direct Arduino pins) with configuration switches. I0.0 and

R5 will not be available. In order to implement this communication a 4.7kΩ pull-up resistor is

required.

The marks with “-” mean that they do not affect the I2C communication protocol.

28



10.Jumper Configuration

10.1 006001001200 Analog General Jumper Configuration

JUMPER ZONE 1

LEFT RIGHT

RS-485 RS-485

D0 D1

RS-232 RS-232

JUMPER ZONE 2

LEFT RIGHT

Q0.9 Q0.8

D4 D8

RS-232 SS RS-232 SS

*The jumpers that are not connected to the middle jumpers MUST NOT be Connected

anywhere.
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10.2 006001001300 Relay General Jumper Configuration

JUMPER ZONE 1

LEFT RIGHT

Y+ Z-

ENABLE ENABLE

A0.0 A0.1

JUMPER ZONE 2

LEFT RIGHT

I0.2 I0.3

D4 D8

RS-232 RS232

JUMPER ZONE 3

DOWN UP

RS-485 RS-485

D0 D1

RS-232 RS-232

*The jumpers that are not connected to the middle jumpers MUST NOT be Connected

anywhere.
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11.Hardware Serial RS-232 & RS-485 Configuration

11.1 006001001200 Analog Hardware Serial RS-485

In order to enable the Hardware Serial RS-485 the total configuration of the Ardbox Analog HF

PLUS will be:

Switch configuration:

TOP ZONE LEFT ZONE

ACTIVATED
SWITCH

MODE ACTIVATED
SWITCH

MODE

RS* ON DE-RS485 ON

RS* OFF DE-RS485 OFF

RS* ON RE-RS485 ON

RS* OFF RE-RS485 OFF

GPRS RST / I0.0 -

SCL-PIN3 / Q0.6 -

Jumper configuration:

ZONE 1 ZONE 2

● Available communication protocols:

○ Hardware Serial RS-485.

○ I2C *If I2C is active I0.0 & Q0.6 are disabled.

○ TTL (SoftwareSerial)

○ USB
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11.2 006001001200 Analog Hardware Serial RS-232

In order to enable the Hardware Serial RS-232 the total configuration of the Ardbox Analog HF

PLUS will be:

Switch configuration:

TOP ZONE LEFT ZONE

ACTIVATED
SWITCH

MODE ACTIVATED
SWITCH

MODE

RS* ON I0.8 OFF

RS* OFF I0.8 ON

RS* ON I0.9 OFF

RS* OFF I0.9 ON

GPRS RST / I0.0 -

SCL-PIN3 / Q0.6 -

Jumper configuration:

ZONE 1 ZONE 2

● Available communication protocols:

○ Hardware Serial RS-232.

○ I2C *If I2C is active I0.0 & Q0.6 are disabled

○ TTL

○ USB
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11.3 006001001300 Relay Hardware Serial RS-485

In order to enable the Hardware Serial RS-485 the total configuration of the Ardbox Relay HF

PLUS will be:

Switch configuration:

TOP ZONE LEFT ZONE

ACTIVATED
SWITCH

MODE ACTIVATED
SWITCH

MODE

RS* ON NC -

RS* OFF HD / FD ON - OFF

RS* ON R5 / Pin 3-SCL -

RS* OFF I0.0 / GPRS RST -

RE-RS485 ON

RE-RS485 OFF

DE-RS485 ON

DE-RS485 OFF

Jumper configuration:

ZONE 1 ZONE 2 ZONE 3

● Available communication protocols:

○ Hardware Serial RS-485.

○ I2C *If I2C is active I0.0 & R5 are disabled

○ TTL

○ USB
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11.4 006001001300 Relay Hardware Serial RS-232

In order to enable the Hardware Serial RS-232 the total configuration of the Ardbox Relay HF

PLUS will be:

Switch configuration:

TOP ZONE LEFT ZONE

ACTIVATED
SWITCH

MODE ACTIVATED
SWITCH

MODE

RS* OFF NC -

RS* ON HD / FD ON - OFF

RS* OFF R5 / Pin 3-SCL -

RS* ON I0.0 / GPRS RST -

I0.4 OFF

I0.4 ON

I0.5 OFF

I0.5 ON

Jumper configuration:

ZONE 1 ZONE 2 ZONE 3

● Available communication protocols:

○ Hardware Serial RS-232.

○ I2C *If I2C is active I0.0 & R5 are disabled

○ TTL

○ USB
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12.Ardbox - Arduino I/Os 5V pins

The Ardbox has one of the Leonardo board pins available. This pin can be programmed

according to Arduino features such as I/Os operating at 5V. As the pin is directly connected to

the Arduino Leonardo board they are not as well protected as the normal inputs. The pin is

mainly meant to be used as prototyping.

Ardbox terminal Arduino pin
SCL – Pin 3 3

*IMPORTANT: Do not connect the pin in the chart above to voltages higher than 5V. This

terminal provides direct access to the Leonardo board.

12.1 I2C pins – SDA/SCL

The I2C protocol is meant to work in a pull-up configuration. The I2C pins in the Arduino

Leonardo are not pull-up, so in order to work with the I2C an external pull-up resistor is

required. If it is meant to work as a GPIO at 5V, the switches must be set as I2C, (section 8).

These pins are not established with a pull-up or a pull-down configuration. The state of these

pins is unknown. If these pins must be used they require a pull-up or a pull-down configuration.

The Arduino board allows the pins to be set in a pull-up configuration. If not it must be

established as an external pull-up or pull-down circuit in order to correctly work with these

pins.

12.2 Pin 3

Pin 3 is only referred to the output Q0.6 for the Analog model and R5 for the Relay model. If

the switch configuration is in OFF position the Pin 3 will be available.

The pin is not established with a pull-up or a pull-down configuration. The state of the pin is

unknown. If the pin must be used, it requires a pull-up or a pull-down configuration. The

Arduino board allows the pin to be set in a pull-up configuration. If not it must be established

as an external pull-up or pull-down circuit in order to correctly work with Pin 3.
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13.GPRS & GSM

The SIM800L module is the integrated module for the use of GPRS / GSM in this PLC. Its

principal features are:

● Quad-band 850/900/1800/1900MHz.

● Only works with 2G technology.

● Can send / receive SMS messages.

● Can send / receive GPRS data (TCP/IP, HTTP, MQTT).

● Controlled by AT Commands (3GPP TS 27.0077, 27.005 and SIMCOM enhanced AT

Commands).

● AT Command interface with transmission speed “automatic” detection.

● Max. transmission speed: 85.6 Kbps.

● Serial transmission speed: 1200 bps up to 115200 bps (Baud rate).

● SIM size: Micro SIM.

When defining the pins in the program, take into account that the internal connections

between the SIM800L module and the Arduino Leonardo are the following:

Arduino Leonardo Pinout SIM800L Pinout

5Vdc Vcc

GND GND

MOSI (Pin 16) TxD

MISO (Pin 14) RxD

Pin 2 GPRS RESET

The GPRS / GSM protocol is always enabled as there are no switches that configure it. The

protocol uses the SPI pins of the equipment to be able to communicate and the Pin 2 for the

module reset.
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14. GPRS & GSM Programming Examples

14.1 How to use the GPRS Module

By following the steps on this post7, you will learn how to work with the GPRS Module that is

inside the PLC. A brief explanation about the examples provided by the Industrial Shields

libraries from GPRS is also done.

14.2 How to send SMS using GPRS from a GPRS Ardbox PLC

Two posts about how SMSs can be sent using GPRS have been written. The first one talks about

sending SMS when a temperature sensor reaches a certain threshold. You can find the post

here8.

The second one is about general features of the GPRS module and describes an example from

Adafruit FONA libraries. Check the link9 to go to the post.

In the examples the communication with an M-Duino GPRS PLC is shown, but the process is

identical with the Ardbox models. Select the correct Ardbox board in the Arduino IDE while

doing any tutorial.

9 https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-send-sms-by-using-plc-controller-arduino-296

8 https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-send-sms-using-gprs-from-an-mduino-403

7 https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-use-gprs-module-158
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15.I/0 technical details

Digital Output Waveform

Digital Output Turn-off
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PWM Waveform

Analog Out Turn-on

Analog Out Turn-off
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Analog/Digital Input Turn-on

Analog/Digital Input Turn-off
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16.Typical Connections

41



42



43



44



17.Connector details

The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 THT – 1963502 from

Phoenix contact. MC0,5/10-G-2,5THT

For I/O and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix

contact. FK-MC 0,5/10-ST-2,5

Connection details:

Article reference MC 0,5/10-G-2,5
THT

Height 8,1mm

Pitch 2,5mm

Dimension 22,5mm

Pin dimensions 0,8x0,8mm

Pin spacing 2,50mm

Article reference FK-MC 0,5/10-ST-2,5

Rigid conduit section min. 0,14 mm²

Rigid conduit section max. 0,5 mm²

Flexible conduit section min. 0,14 mm²

Flexible conduit section max. 0,5 mm²

Conduit section AWG/kcmil min. 26

Conduit section AWG/kcmil max. 20
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18.ARDBOX Family Dimensions

45mm width

- DIN rail mounting:
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19.Installation and Maintenance

Notes for installation:

- The installation position should be free from the following: dust or oil smoke,
conductive dust, corrosive or flammable gas, high temperature, condensation, and
rain.

- Besides, vibration and impact also affect the PLC normal operation and shorten its
lifespan; electric shock, fire or misact also damages the product. During drilling or
wiring, prevent the metal particles or wire segments from falling into the PLC casing,
which may cause fire, fault or misact.

- After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.

- Do not online connect, plug or unplug cables, which are apt to cause electric shock or
damage the circuit. Installation and wire connection must be firm and reliable. Poor
connection could cause misact.

- Use shielded twisted pairs for the I/O of high frequency signal and analog signal to
improve system IMS.

The installation environment should be free from dust, oil smoke, conductive particles,
corrosive or flammable gases, high temperature, condensation, and rain.

Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan.
It is recommended to install the PLC, together with the matching switches and contactors,
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high
ambient temperature or heat generating equipment nearby, install forced convection
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring,
prevent the metal particles or wire segments from falling into the PLC casing, which may
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent
blocking, which may cause bad ventilation, or even fire, faults or misact.

The only way to disconnect the equipment from the electrical network is by removing the
connectors that feed the equipment. Once installed in the electrical cabinet it is very
important to ensure the power connectors for proper operation.

Separate the ARDBOX 20 I/Os Family HF PLUS from heat, high voltage and electrical
noise:

Always separate the devices that generate high voltage and high electrical noise from the
ARDBOX 20 I/Os Family HF PLUS. When configuring the layout of the ARDBOX 20 I/Os
Family HF PLUS inside your panel, consider the heat-generating devices and locate the
electronic-type devices in the cooler areas of your cabinet. Reducing the exposure to a
high-temperature environment will extend the operating life of any electronic device.
Consider also the routing of the wiring for the devices in the electric cabinet. Avoid placing
low-voltage signal wires and communications cables in the same tray with AC power wiring
and high energy, rapidly-switched DC wiring.
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Provide adequate clearance for cooling and wiring ARDBOX 20 I/Os Family HF PLUS. Is designed
for natural convection cooling. For proper cooling, you must provide a clearance of at least 25
cm above and below the devices. Also, allow at least 25 cm of depth between the front of the
modules and the inside of the enclosure.

Notes for maintenance:

A well-planned and executed maintenance program is essential to the satisfactory operation of
solid-state electrical equipment. The kind and frequency of the maintenance operation will
vary with the kind and complexity of the equipment as well as with the nature of the operating
conditions. Maintenance recommendations of the manufacturer or appropriate product
standards should be followed.

The following factors should be considered when formulating a maintenance program:

- Maintenance must be performed by qualified personnel familiar with the construction,
operation, and hazards involved with the control.

- Maintenance should be performed with the control out of operation and disconnected
from all sources of power.

- Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

- Ventilation passages should be kept open. If the equipment depends upon auxiliary
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when
necessary) should be made of these systems.

- The means employed for grounding or insulating the equipment from ground should
be checked to assure its integrity.

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks,
should be removed according to the manufacturer's instructions, if provided;
otherwise, the manufacturer should be consulted. Care must be taken to avoid
damaging any delicate components and to avoid displacing dust, dirt, or debris in a way
that permits it to enter or settle into parts of the control equipment.

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and
dirt should be removed from the top of the enclosures before opening doors or
removing covers.

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g.,
polychlorinated biphenyls (PCBs) found in some liquid filled capacitors) must be
disposed of as described in Federal regulations.

Safety rules for maintenance personnel

Consider the following steps to follow. A false manoeuvre could be the cause of an
accident or material damage.
Do not disassemble or modify the modules. This could lead to breakdowns or
malfunctions and could lead to injuries or fire.

- All types of radio communication devices, including mobile phones and personal
handy-phone systems (PHS), must be kept more than 25cm away from the PLC in all
directions. Failure to observe this precaution exposes malfunctions caused by excess
temperature.
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- Disconnect the external power supply of the system (on all phases) before connecting
or disconnecting a module. Failure to observe this precaution may cause faults or
malfunctions of the module.
- Tighten the screws of the terminal ports and the screws of the connectors within the
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires
and cause malfunctions. Excessive tightening can damage the screws and / or the
module, with the risk of falling, short circuits and malfunctions.
- Before handling a module, dispose of the electrostatic charge accumulated by the
human body by touching a suitable conductive object. Failure to observe this
precaution may cause faults or malfunctions of the module.

Repair note:

If the equipment is suitable to be repaired, it must be verified that the equipment
remains in a safe state after repair.
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20.Revision Table

Revision Number Date Changes
0 30 / 08 / 2019 First implementation
1 04 / 03 / 2020 Second implementation
2 19 / 10 / 2022 Family implementation
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About Industrial Shields:

Direction: Fàbrica del Pont, 1-11

Zip/Postal Code: 08272

City: Sant Fruitós de Bages (Barcelona)

Country: Spain

Telephone: (+34) 938 760 191 / (+34) 635 693 611
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Mail: industrialshields@industrialshields.com
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